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Preface

This document jump-starts the process of learning how to use Application 
Configuration Console.

Audience
This document is intended for anyone who wants to understand how Application 
Configuration Console is intended to be used as a configuration management tool. 

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

Deaf/Hard of Hearing Access to Oracle Support Services
To reach Oracle Support Services, use a telecommunications relay service (TRS) to call 
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle 
technical issues and provide customer support according to the Oracle service request 
process. Information about TRS is available at 
http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone 
numbers is available at http://www.fcc.gov/cgb/dro/trsphonebk.html.
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Related Documents
For more information, see the following documents in the Application Configuration 
Console documentation set:

■ Release Notes

■ PCI Compliance

■ Installation Guide

■ Command Line Interface Reference

■ Performance and Tuning Guide

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1 About This Book

Congratulations. Your company has purchased the pre-eminent configuration, change, 
and release management software available on the market today. Application 
Configuration Console counters IT complexity and compliance with automation 
software that eliminates configuration management chaos in application 
infrastructure.

1.1 Scope
Application Configuration Console is a powerful, highly versatile tool in the hands of 
your IT infrastructure team. This book offers merely a glimpse; its purpose is to 
jump-start the process of harnessing that power. Thus, the scope is necessarily narrow 
and focuses on some of the basic tasks IT departments typically perform. The book 
also covers the first few things you need to do before you can perform these tasks.

1.2 Objectives
After you read this book, you should be comfortable enough with the application to 
perform basic tasks such as loading assets, tracking changes, comparing resources, and 
synchronizing your data.

1.3 Are You Ready to Get Started?
To answer in the affirmative, you have to have all your ducks in a row. This means that 
all of the following conditions have been met:

■ You have installed and configured the Application Configuration Console 
software.

■ Your Oracle database is accessible to the Application Configuration Console 
Server.

■ LDAP (or some other) directory services are in place.

■ Targeted resources have been identified.

■ SSH (or FTP) support is in place to access hosts where resources reside.

If you need additional information on any of these requirements, see the Application 
Configuration Console Installation Guide.
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1.4 One More Thing
This book introduces the fundamentals; the tasks that are presented here are fairly 
straightforward. At the conclusion of each simple task, however, a section summarizes 
additional or advanced topics that emanate from the basic concept. For detailed 
information on Application Configuration Console features and how to use them, 
consult the Application Configuration Console Online Help.
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2 Application Configuration Console
Overview

Before tackling some specific tasks, let's take a tour of the Application Configuration 
Console user interface and review some terminology to reach a certain comfort level.

2.1 Product Architecture
As you can see in Figure 2–1, Application Configuration Console is a multitiered 
application that has client and server components, a database repository, and your 
company's network infrastructure, which represents the targeted resources to be 
managed by the software.

Figure 2–1 Application Configuration Console Architecture

The targeted resources are the application servers, Web servers, operating systems, 
and so forth, that you are managing. To Application Configuration Console, these 
managed servers are assets that consist of configuration and other files. You can 
organize these assets in the Client into hierarchical containers that mirror your 
infrastructure. Using the Client, you work through the Application Configuration 
Console Server to load and manage the assets. Using a Web browser, you can access 
your managed data to generate Application Configuration Console Web Reports. The 
Server uses an Oracle database to store data and a Subversion (SVN) server for 
versioning control. There may or may not be a firewall between the managed 
resources and the Application Configuration Console Server.
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2.2 Application Configuration Console User Interface
Open the Client UI; notice that it is divided into discrete windows, or frames.

The Navigator view displays your projects and configurations and how they relate to 
each other in a hierarchy similar to a file explorer. In Application Configuration 
Console, all configuration information is organized under projects. Projects can contain 
other containers and/or assets with configurations. Right-click an item in the 
Navigator view to select from a menu of possible actions. Menu options change 
according to the item clicked. Breadcrumbs provide a hierarchy path to where you are 
in the Navigator view relative to the selected item.

The Editor area shows the contents of configurations and metadata about containers 
and configurations. When you double-click an item in the Navigator view, Application 
Configuration Console opens it in the Editor area for further operation. You can open 
multiple items simultaneously. Tabs at the bottom control different aspects of how you 
view and work with the open item.

Other views, the most common of which are the Alerts view, which shows alerts if 
there are changes to any configurations that you are tracking; Jobs view, which shows 
a list of jobs (scripts) scheduled to be or already executed; Synchronize view, which 
shows changes between a container in Application Configuration Console and its 
external resource.

The Details area displays information about the item that is currently selected in the 
Navigator view. The information varies, depending on the type of item selected.

2.3 Terminology
The terms listed in this section should help in understanding the concepts and tasks 
presented in the remainder of this book. For a more extensive list of Application 
Configuration Console (and industry) terms, see the .

Alert
Notification that a difference was detected between elements such as an asset and its 
external resource, as a result of a scheduled event. Alerts appear in the Alerts view of 
the Application Configuration Console Client. You can optionally receive e-mail 
notification of the alert.

Asset
The key component in Application Configuration Console. Assets represent the 
servers, devices, and systems that you manage. For example, Web servers and 
application servers are both represented as assets.

Authentication Pack
Often shortened to auth pack. An authentication pack contains a username and 
password (encrypted), or an SSH certificate and passphrase, or similar credentials. An 
auth pack allows you to connect to a host where your external resources reside.

Base Directory
Specified on a resource specification as the starting point on a host machine from 
which to locate the configuration files of an asset.
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Compare
To evaluate two or more containers or configurations for any differences between the 
elements being compared.

Configuration
An object that contains configuration information, such as properties and their values. 
Assets contain configurations, where each configuration usually represents the 
configuration information from a single configuration file, such as an XML file that 
contains application server settings.

Container
An object that contains configuration information, such as properties and their values. 
Assets contain configurations, where each configuration usually represents the 
configuration information from a single configuration file, such as an XML file that 
contains application server settings.

Endpoint
Protocol (either FTP, SSH, or UNC) used to transfer information over the network. 
Specified in combination with the host where the external resources reside.

External Resource
The source of an asset. A resource is external in the sense that it exists outside of 
Application Configuration Console, somewhere in your computing infrastructure.

Host
An addressable machine in your network where external resources reside. A host has 
an associated endpoint or protocol to use when connecting to it.

Mapping
Mappings control the way in which configuration information in external resources is 
brought into Application Configuration Console and displayed in the container tree. 
Application Configuration Console supports a variety of specialized and generic 
mappings.

Metadata
Metadata takes two forms. As system-defined, metadata is annotational information 
about a container or configuration, such as when it was created or who last made 
changes. Metadata can also be user-defined, and as such, is most commonly used to 
drive value substitution for things such as comparison settings, variables, Navigation 
view hierarchies, and so forth.

My Workspace
A hierarchy of projects, containers, and configurations within Application 
Configuration Console that is your private work area, and as such, cannot be seen by 
anyone else.

Parsing
Parsing is the first stage of the mapping process, where the physical representation of a 
configuration file is converted to an internal storage called a syntax tree.
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Permissions
Granted to user groups to enable group members to view and change assets and 
configurations, execute commands and scripts, and provision and update assets and 
configurations.

Physical View
This is the raw text view of a configuration as it is stored in the external resource when 
the asset was loaded or updated.

Primary View
This is the parsed view of a configuration transformed for display in the Editor area 
based on file type, such as XML. A typical display is property name/value pairs 
within elements. This is the default view of a configuration.

Provision
To commit, or write out, an asset from Application Configuration Console to its 
external resource counterpart. This is the only Application Configuration Console 
action that modifies an external resource.

Public Workspace
A hierarchy of projects, containers, and configurations within Application 
Configuration Console that can be seen by everyone. When you share something in 
your My Workspace, it is visible here to those you share with.

Resource Definition
The details portion of a resource specification where you define the make-up of the 
external resource, such as the file name and type of mapping to use.

Resource Specification
Often shortened to resource spec. Identifies the files and resources that can be loaded 
as assets into Application Configuration Console from remote systems. There are two 
types of resource specification: one, file resource specification, for loading the files and 
directories that constitute the asset; the other, command resource specification, for 
saving the output of commands as the asset. Both types consist of one or more 
resource definitions that provide the details of the external resource.

Resource View
The default asset view. This view represents the way the asset's configurations appear 
in the external resource.

Roll Back
To restore a previous version of an asset or configuration following a provision or 
update action.

Synchronize
To determine whether changes exist in Application Configuration Console or the 
external resource and then to make them the same by updating one or provisioning 
the other.
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Tracking
To monitor assets and configurations for the purpose of detecting changes in 
Application Configuration Console or in an external resource. Upon detecting a 
change, Application Configuration Console posts an alert and optionally sends an 
e-mail notification to a designated recipient.

Transform
Transform is the second stage of the mapping process. It converts configuration data 
from the internal storage format into a structured representation for display in a 
configuration view.

Update
To overwrite an asset in Application Configuration Console with its external resource 
counterpart.

Versioning
To overwrite an asset in Application Configuration Console with its external resource 
counterpart.

2.4 Who Can Do What
Although it doesn't necessarily come into play in this book, it is useful as part of this 
overview to point out certain aspects of the permissions model that Application 
Configuration Console enforces.

When you create something in Application Configuration Console, you are the owner. 
As the owner, only you can share what you create with other users. When you share 
something, it becomes viewable to those you share it with in the Public Workspace. 
You can transfer ownership to someone else, in which case it is removed from your My 
Workspace folder and appears in the new owner's My Workspace folder.

Besides the typical permissions of read and write, there are additional permissions 
exclusive to auth packs (read external, write external, execute external), which grants 
the holder the right to perform operations involving external resources, such as 
provision, update, track, and compare. Groups control which users have permission to 
view and change information in Application Configuration Console. A group contains 
one or more Application Configuration Console users. When you share a container or 
configuration, you set permissions for groups of users, not individual users. You can 
give different permissions to different groups, such as read permission or write 
permission.

Users of the system fall into two major groups, the Administrators group and the All 
Users group. Users of both of these groups originate in an external authentication 
system such as an LDAP directory service that is identified as part of Application 
Configuration Console installation. Thus, you cannot add new users directly to the 
Application Configuration Console user roster; they have to be added to the service.

Members of the Administrators group have permissions and capabilities not available 
to other users, enabling them to:

■ Transfer ownership to another user; this includes items in the Public Workspace as 
well as items in some other user's My Workspace folder.

■ Force an unlock (Application Configuration Console locks an item such as an asset 
when in edit mode; if a lock persists for some reason after the editing session ends, 
it needs to be released).
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■ Create new user groups (implies assigning members and setting permissions).

■ View and manage jobs in the Jobs view (implies canceling pending and running 
jobs and removing completed jobs).

■ Display a list of Application Configuration Console users currently connected to 
the system and the total number of connections.

■ Install and uninstall Application Configuration Console extensions (extensions are 
optional product add-ins such as the WebSphere and WebLogic automation 
modules).

■ View and change system configuration settings.

■ Use Server Browse (this is a special authentication pack to access the host system 
of Application Configuration Console).
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3 First Things First

Before you can start working with assets, you have to lay the groundwork. This does 
not refer to the installation and set up of Application Configuration Console and 
related software, which, as stated in Chapter 1, must already be in place.

Rather, laying the groundwork means you have to shape assets in terms of the 
resources they represent. Specifically, you have to map the following aspects of the 
external resource to Application Configuration Console concepts:

Hosts, authentication packs, and resource specifications work together to let the 
Application Configuration Console Server read and write configuration data to and 
from managed servers and devices. Each managed server or device is represented as 
an asset in Application Configuration Console, and you must have a host, an 
authentication pack, and a resource specification to create an asset.

3.1 Create a Host and Endpoint
The first thing to do is to add a host and endpoint, that is, the machine on which the 
external resource resides, and the connection protocol to use to access it.

1. In the Navigator view, expand System > Connectors.

2. Right-click Hosts and select Add Host from the popup menu.

3. In the Add Host dialog, enter the machine addressable host name or IP address.

4. Click Add to define an endpoint for the host, as follows:

a. Define the type by selecting SSH from the drop-down menu.

b. This populates the name and port fields with the default values SSH and 22. 
Keep these values unless you have some reason to change them.

c. Click OK to complete the endpoint definition.

You return to the Add Host dialog, where the endpoint now appears in the list.

External Resource Application Configuration Console Concept

Where are they? Host/endpoint

Who can access them? Authentication pack

What do they consist of? Resource specification

Note: The tasks in this chapter assume that you are already logged in 
to the Application Configuration Console Client.
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5. Enter a description of the host, if you like, then click OK to complete host creation.

3.1.1 Other Things to Know About Hosts/Endpoints
Note the following additional points about hosts and endpoints:

■ A host only gets added once. All users can see it, and connect to it with the right 
credentials. Only the owner can modify the properties.

■ A host can have multiple endpoints.

■ Endpoints have advanced settings related to things such as connection timeouts 
and autodetection settings.

3.2 Create an Authentication Pack
Next, you will need an authentication pack containing the credentials necessary to 
connect to the host you just added.

1. In the Navigator view, expand System > Connectors.

2. Right-click Authentication Packs and select Add Authentication Pack from the 
popup menu.

3. In the Add Authentication Pack dialog, enter a descriptive name for the auth pack.

4. Make sure that the type selected is Username Password.

5. Enter your username and password in the text boxes provided.

6. In the Validation portion, click the check box and select the host/endpoint that 
you previously created, from the drop-down list. This is not required, but it does 
present an opportunity to ensure that you can connect to the host with the 
credentials you provide. In any case, if the validation test fails, you can still create 
the auth pack now, and set up the credentials on the host later.

7. Click OK to complete auth pack creation.

3.2.1 Other Things to Know About Authentication Packs
Note the following additional points about authentication packs:

■ Auth packs can be shared with other users (passwords are always hidden).

■ Auth packs are not restricted to username/password combinations. They can also 
be specified as an SSH certificate and passphrase or other similar credentials.

■ There is a secure provision variety of auth pack for use with access control systems 
such as sudo, su, and pbrun.

■ Users need special permissions on an auth pack to interact with external resources 
(to provision, update, synchronize, and so forth).

3.3 Create a Resource Specification
Now create a resource specification to shape the contents of assets to be loaded into 
Application Configuration Console. The assumption at this point is that you have 
identified an external resource, an application server for example, that you want to 
load as an asset into Application Configuration Console. A set of configuration files 
exist on the targeted host that constitute the asset.

1. In the Navigator view, expand System.
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2. Right-click Resource Specifications and select Add File Resource Specification 
from the popup menu.

3. In the Add File Resource Specification dialog, enter a descriptive name for the 
resource spec.

4. Select the Host/Endpoint you created from the drop-down list.

5. Select the Authentication Pack you created from the drop-down list.

6. Browse to the Base Directory, which is the starting point on the host machine 
where the asset configurations reside. When you click the Browse button, a dialog 
opens, exposing the file system on the host machine to which you have access, 
based on the credentials in the auth pack.

7. Complete the file resource definition portion of the resource spec by including the 
configuration files that constitute the asset. To do this, click the Add File button to 
open a dialog and select the files in the base directory.

Notice the preselected check box Automatically assign mappings. This indicates a 
willingness to acknowledge that the software is smart enough to know how to 
store and display the files in Application Configuration Console, based on file 
type. This will often be the case.

8. Click OK to complete resource specification creation.

3.3.1 Other Things to Know About Resource Specifications
Note the following additional points about resource specifications:

■ Resource specs can be shared with other users.

■ When you use the resource spec to load an asset, you can change the resource 
locator information (host, auth pack, base directory).

■ You can use wildcards and regular expressions as an alternative to manually 
selecting which files to include.

■ You can customize the file mappings to any of an extensive list of parsers 
supported by Application Configuration Console.

■ You can include a directory as part of the resource spec to monitor changes in the 
file list within the directory.

■ You can define metadata to be part of each asset loaded with the resource spec.

■ You can change a resource spec and reapply it to assets you have already loaded, 
optionally overwriting any existing metadata.

■ The example used here covers a file resource specification. There is also a 
command resource specification that creates an asset from the output of a 
command execution.
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4 Asset Load

With the underpinnings in place, you are now ready to load assets into Application 
Configuration Console.

4.1 Organize Your Assets
Part of the process of loading assets is to build a hierarchical structure that mirrors 
your operation. In Application Configuration Console, you load assets and 
configurations into objects called containers. The top-level container is a project. Under 
projects you can have environments, layers, and folders. Or you can have no other 
container levels. Remember, these are devices that you can use as necessary to fit your 
organizational structure. If you want to give them different labels, feel free to do so.

Figure 4–1 shows an example structure that will serve as backdrop for discussions in 
the remainder of this book:

Figure 4–1 Sample Containers Used in Examples

Note: The tasks in this chapter assume that you are already logged in 
to the Application Configuration Console Client.
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In particular, we'll work with the Portal Lifecycle View project that has the 
Development, Staging, and Production environments, each with a Web Server and 
App Server layer.

4.2 Add Assets
Assets represent external resources, such as an application server, a Web server, or a 
router. They contain the Application Configuration Console configurations that hold 
the configuration data from the external resources. You can add an asset under any 
container in your hierarchy, such as directly under a project or under a layer.

Working with the foundation we've put in place, we're going to add an asset as 
follows:

1. In the Navigator view under 4, expand Portal Lifecycle View > Development.

2. Right-click App Server and select Add > Asset.

The Add Asset dialog opens.

3. Enter a name for the asset, Server1, for example.

4. We're creating from a resource specification, so make sure that's the radio button 
selected, then locate the resource spec we created in Chapter 3 (RS-XML) in the 
drop-down list.

After a moment, the Host/Endpoint, Authentication Pack, and Base Directory 
fields are filled in, based on the resource spec selected.

5. Click OK to load the asset configurations.

After a moment, you should see a message denoting the success of the operation.

If you look at the Navigator view, you'll see the asset Server1 and its configurations as 
determined by the resource spec under the App Server container.

Resource View represents the default asset view, that is, as the asset's configurations 
appear in the external resource. The Physical View of a configuration is its raw text 
format; the Primary View is a parsed view of a configuration arranged as elements and 
property-value pairs in a container hierarchy. Note that you can create your own 
custom asset views; they are a handy way of subdividing an asset's configurations into 
logical groupings.

4.2.1 Other Things to Know About Adding Assets
Note the following additional points about adding assets:

■ When adding an asset based on a resource spec, you can change the 
host/endpoint, auth pack, and base directory to target different resources. What 
remains constant is the file resource definition.

■ You can add an asset based on an existing asset. The asset you are adding then 
becomes subordinate to its master, the asset it is based on. This means that the 
subordinate's configuration values derive from the master asset, not from an 
external resource.

■ You can add an asset based on a template that represents an asset standard or 
model within your organization.
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4.3 Build Out the Model
Behind the scenes, we've fleshed out the data to demonstrate additional functionality 
covered in later chapters. We created a new resource spec (RS-CONF) to load another 
asset (Aeneas). We also populated the Staging environment layers with the same 
assets from the Development environment. Consequently, the Navigator view now 
appears as shown in Figure 4–2:

Figure 4–2 Sample Containers Extended

Additionally, we've contrived to introduce some differences so things happen when 
we perform tasks in later chapters. If you're playing along at home, you may want to 
make some edits to your data, so you experience similar results.

Note: Please keep in mind that, while we're working with just a 
couple of assets that have a small number of configurations, in reality, 
it's not uncommon for enterprises to load hundreds of assets that 
contain thousands or even tens of thousands of configurations.
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5 Track, Compare, Find and Replace

Application Configuration Console provides versatile tools to monitor and oversee 
your IT infrastructure.

5.1 Track Assets and Configurations
The tracking feature lets you see alerts and receive e-mail when there are changes to 
configurations in Application Configuration Console or to external resources.

Let's set tracking on the Server1 asset.

1. In the Navigator view, expand Portal Lifecycle View > Development > App 
Server > Server1.

2. Right-click Resource View and select Open.

You set tracking on an asset view. Since the only view we have right now is the 
Resource View, that's the one you have to select.

3. At the bottom of the Editor area, click the Tracking Schedule tab.

4. Click the Edit button (upper-left corner). You won't be able to do anything until 
you do.

5. Click the Enable Tracking check box and select an option. In this case, make it 
Track Configurations.

6. Now select a specific configuration, in this case, config.xml.

7. Since this is for demonstration purposes, we'll set the schedule at the next hour on 
today only.

8. We want notification when differences are detected, so we'll supply an Email 
Address in the space provided.

9. Click Save to complete the scheduling operation.

5.1.1 Other Things to Know About Tracking
Note the following additional points about tracking:

■ You can track single or selected configurations, or the entire asset.

Note:  The tasks in this chapter assume that you are already logged 
in to the Application Configuration Console Client.
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■ In a typical scenario, you would set up a recurring schedule, for example, every 
day of the week at 1:00 a.m., 12 months a year. Incidentally, off-hours is best from a 
performance standpoint.

■ You are always notified in the Alerts view of Application Configuration Console 
when a difference is detected. E-mail notification is optional.

■ The Update option at the bottom of the scheduling dialog, when set to Replace, 
causes the Application Configuration Console configuration to be overwritten 
with the external resource automatically, whenever a difference is detected.

5.1.2 When Tracking Detects a Difference
When tracking detects a difference, Application Configuration Console posts an alert 
in the Alerts view, identifying the time of detection and the respective paths of the 
internal and external data being compared.

The alert is a hyperlink. Double-click it (or right-click and select Open in Compare 
View) to display detected differences in the Editor area. The resulting Compare view 
shows rows that contain differences in a bold font with property differences 
highlighted.

If you opt for e-mail notification, you automatically receive a message with body 
content that provides information similar to that posted in the Alerts view. At the 
bottom of the message is a URL; click it to view the Application Configuration Console 
Web Reports Comparison Report in your browser, where you see the same information 
displayed in the Editor area when you open the alert in the Compare view.

5.2 Compare Assets and Configurations
You can compare two or more containers or configurations to quickly identify 
configuration differences, which are often the source of problems in applications. You 
can compare individual configurations or entire container trees. You can also compare 
an asset or configuration with its external resource to see any differences between the 
Application Configuration Console data and the external resource data.

Let's do a simple compare of two containers, the respective Web Server layers in the 
Development and Staging environments.

1. In the Navigator view, click the Web Server layer under the Development 
environment, then ctrl-click the Web Server layer under the Staging environment.

2. Right-click and select Compare from the popup menu.

3. In the Comparison Options dialog that opens, accept the defaults and click OK.

After a moment, the results of the comparison appear in the Editor area. The 
resulting Compare view shows all of the properties in the left column and the 
values from each container or configuration in additional columns. Any container 
rows that contain differences are shown in a bold font, and properties with 
differences are highlighted.

Notice that the containers being compared have the same name-Web Server. This 
can sometimes be confusing when viewing comparisons, so Application 
Configuration Console gives you the capability to rename the columns to 
something more meaningful, in this case, perhaps, to the respective environments. 
To change the name of a column, right-click under the respective column name 
and select Rename Column. Figure 5–1 shows the columns already renamed, with 
the right-click menu selection exposed:
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Figure 5–1 Comparison Results with Columns Renamed

In the first comparison, we compared containers within Application Configuration 
Console. Now let's compare Application Configuration Console data to its external 
resource.

1. In the Navigator view, expand Portal Lifecycle View > Development > App 
Server > Server1 > Resource View.

2. Right-click config.xml and select Compare to Resource in the popup menu.

3. In the Comparison Options dialog that opens, accept the defaults and click OK.

After a moment, the results of the comparison appear in the Editor area, for 
example. This is an expanded view to expose the difference detected in the 
comparison. Column headings in the Compare view distinguish the Application 
Configuration Console data from the external resource data.

Now let's compare the same entities, only this time we'll compare the Application 
Configuration Console configuration content (raw text form) to its external 
counterpart.

1. In the Navigator view, expand Portal Lifecycle View > Development > App 
Server > Server1 > Resource View.

2. Right-click config.xml and select Compare Content to Resource in the popup 
menu.

After a moment, the results of the comparison appear in the Editor area. Notice 
that this comparison displays in the Physical View, showing a physical (text) 
representation of the configuration and its external resource. You can edit content 
and normalize values in either direction; that is, in the Application Configuration 
Console data or the external resource.

5.2.1 Other Things to Know About Comparisons
Note the following additional points about comparisons:

■ You can edit or normalize values when differences are detected. Say, for example, 
a comparison of six configurations flagged differences in the values of a particular 
property, and you wanted to make them all the same. You could do that by 
choosing to normalize the row to a selected value.



Find and Replace Operations

5-4 Oracle Enterprise Manager Application Configuration Console Getting Started

■ In some cases, you know in advance that a comparison will detect differences, 
server names or port numbers for example. You can choose to have comparisons 
ignore certain properties either temporarily or permanently to cut down on 
differences clutter.

■ Some comparisons you will want to run again and again. After you establish 
comparison criteria and run the comparison the first time, you can save the 
particulars of the comparison to run at will.

■ You can share saved comparisons with others. You also can set up a schedule to 
run saved comparisons automatically on a recurring basis. Scheduled comparisons 
work the same as tracking in that differences are posted to the Alerts view and can 
generate e-mail notifications.

■ Sometimes, even though you might think that you are comparing like entities, 
Application Configuration Console sees them as apples and oranges. This is 
mainly due to use of different property names and misaligned placement within 
configuration files. Metadata in the form of something called a comparison key 
and stored rule sets known as Savespecs afford sophisticated techniques to 
overcome obstacles to straight-up comparisons.

5.3 Find and Replace Operations
Application Configuration Console has a powerful find and replace capability that 
enables you to search not only for property values in your data but also for specific 
settings you have specified relative to the operations you perform within Application 
Configuration Console.

A compare operation performed earlier in the chapter revealed a discrepancy in a 
timeout value. For demonstration purposes, let's say you want to find every 
occurrence of this discrepancy within a project and reset the value accordingly.

1. In the Navigator view, right-click Portal Lifecycle View and select Edit > Find 
And Replace.

2. In the Find And Replace dialog that opens, set the criteria as follows:

a. If it is not the current display, click the Properties tab.

b. Select the Name and Value radio button.

c. Enter Timeout for the property name.

d. Enter 1000 for the current value.

e. Enter 300 for the replacement value.

3. Click Find. Notice the result of the operation.

4. Click Replace to overwrite the current value with the replacement value.

In a search results list with multiple entries, Application Configuration Console 
jumps to the next list entry. If you click Replace All, Application Configuration 
Console updates all entries in the list without any further interaction.

5.3.1 Other Things to Know About Find and Replace Operations
In addition to property and value searches, you can also search on the following:

■ Container names

■ Container metadata



Find and Replace Operations

Track, Compare, Find and Replace 5-5

■ Tracking or provision settings

■ Authentication pack settings

■ Host and endpoint settings

■ Resource specification settings

■ Group names and users in groups

Note: All replacement property values are validated against stated 
requirements in Application Configuration Console so that you cannot 
set invalid values.
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6 Provision, Update, Version

The logical extension to detecting differences, as covered in the previous chapter, is 
what to do about it. Do you want to synchronize property values? Which value takes 
precedence, the one in Application Configuration Console, or the one in the external 
resource? Or do you want to go back to a fixed point in time when you know the 
numbers were reliable?

This chapter explores these options and how to implement them.

6.1 Provision
Provisioning is pushing out assets and their configurations from Application 
Configuration Console to the targeted resources that constitute your business 
infrastructure. The implication is that once having loaded your assets into Application 
Configuration Console, you committed to managing your assets within, and consider 
any changes made outside the bounds of the application to be unwarranted and thus 
to be overwritten.

In Chapter 5, a comparison of config.xml to its external resource detected a 
difference. Since, for the purposes of this discussion, the Application Configuration 
Console version is considered to be correct, we are going to provision this version.

There are a variety of ways to initiate a provisioning operation. The process that 
follows demonstrates one way:

1. In the Navigator view, expand Portal Lifecycle View > Development > App 
Server.

2. Right-click Server1 and select Synchronize > Synchronize View from the popup 
menu.

3. In the Synchronize Options dialog that opens, accept the default selection (Show 
outgoing changes) and click OK.

The Synchronize view that opens tells us that a single configuration (config.xml) 
in the Server1 asset differs from its external resource.

4. Right-click the asset (Server1) and select Provision from the popup menu. The 
Provision dialog opens. A few comments about the dialog:

– Tag and Comment are optional. We filled in a comment but no tag.

– We want to run now as opposed to a later time.

Note:  The tasks in this chapter assume that you are already logged 
in to the Application Configuration Console Client.
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– Since we did not select Include All Configurations, only the changed 
configuration will be provisioned.

5. Click OK to execute the provision operation. After a moment, a message denotes 
success (or failure) of the operation.

6.1.1 Other Things to Know About Provisioning
Note the following additional points about provisioning:

■ When you do a Synchronize view, the resource spec is re-evaluated to pick up any 
changes to files added or deleted.

■ You also can provision from the context (right-click) menu in the Navigator view. 
It opens the same provision dialog.

■ Application Configuration Console has built-in protection in the event the external 
resource has changed since the initial load or the last update (Stop on Conflict). 
This allows you to investigate the difference and make an informed decision about 
allowing the provision to proceed.

■ You can schedule a provision to occur at a later time, either as a one-time 
occurrence, or on a recurring basis.

■ Application Configuration Console supports a form of secure provisioning that 
works with sudo and PowerBroker environments to provide access control and 
audit trail functions.

■ When you provision a master asset, you have the option of provisioning some or 
all of the associated subordinate assets at the same time (the Provision dialog 
changes to accommodate this option).

6.2 Update
Updating is pulling assets and configurations into Application Configuration Console 
from external resources. This is what you do initially to create assets, so when you 
perform an update, you overwrite the Application Configuration Console data with 
the current external resource. The implication is that you use Application 
Configuration Console to monitor activity, but institute change outside the application.

An earlier comparison between assets in Application Configuration Console detected 
a difference in the timeout property value between httpd1.conf files. Since we're 
unsure which is correct, we decide to pull in the value from the external resource.

1. In the Navigator view, expand Portal Lifecycle View > Development > Web 
Server.

2. Right-click Aeneas and select Synchronize > Update from the popup menu. The 
Update dialog opens.

3. The dialog is fairly simple. Tag and Comment are optional. You can expand the 
selected Container to choose individual configurations, if desired (we're going to 
leave it as is). Click OK to execute the Update operation.

After a moment, a message denotes success (or failure) of the operation:

Note that a configuration was skipped. We updated at the asset level, and only one 
of the two configurations in Application Configuration Console was different from 
its external resource.
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6.2.1 Other Things to Know About Updating
Note the following additional points about updating:

■ When you update an asset, the resource specification is re-evaluated to pick up 
any changes and to identify new or deleted external files.

■ If you perform an update operation on a subordinate asset, the configuration 
information updated from the external resource will be overwritten the next time 
the subordinate is refreshed from its master.

6.3 Version
A version is a snapshot in time of an asset and its configurations. Events such as 
provisions, updates, and tracking cause versions to be saved automatically. Saved 
versions include both Application Configuration Console data and external resources. 
Versions provide an audit trail and a recovery mechanism.

For a simple case, let's consider the configuration we just updated (httpd1.conf):

1. In the Navigator view, expand Portal Lifecycle View > Development > Web 
Server > Aeneas > Resource View.

2. Right-click httpd1.conf and select Open from the popup menu.

3. In the Editor area, click the Versions tab at the bottom to see all versions of this 
configuration since initial load, as shown in Figure 6–1:

Figure 6–1 Saved Versions of an Asset Configuration

As you can see, there currently are three versions of this configuration:

■ As it was when first loaded into Application Configuration Console

■ As it was immediately prior to the update

■ As it is now, based on the current content of the external resource

This graphic shows the commands available from the context (right-click) menu. If 
you multiselect versions, the context menu changes to offer the five compare 
operations shown here in the top portion.
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Clearly, maintaining an audit history such as this gives you considerable recovery and 
reconciliation options in maintaining the integrity of your assets.

6.3.1 Other Things to Know About Versioning
Note the following additional points about versioning:

■ When you view the versions of an asset, you see all versions of all configurations 
under that asset.

■ While versions are created automatically based on events such as provisions, 
updates, and so forth, you can save a version of an asset or configuration on 
demand, from the Navigator view.
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7 Web Reports

Application Configuration Console Web Reports provide a powerful tool for 
monitoring and managing activities within the IT infrastructure. They allow users and 
administrators to be proactive rather reactive to the skews and anomalies that crop up 
in enterprise computing networks.

7.1 Access to Web Reports
Web Reports are browser-based; you do not need the Application Configuration 
Console Client to view and generate reports. You do, however, need proper 
credentials, as you have to log in after pointing your browser at this URL:

https://oaccservername:9943/mvwebreports/

Where oaccservername is the host where the Application Configuration Console 
Server is installed. Enter your username and password to log in to Application 
Configuration Console Web Reports. The browser window displays the Web Reports 
home page, where you can schedule and generate reports.

7.2 Report Summaries
Web Reports are grouped by category and provide a cross-section of statistical and 
graphical information about activities involving assets and configurations managed in 
Application Configuration Console. Table 7–1 summarizes the individual reports.

Table 7–1 Summary Descriptions of Individual Web Reports

Category Reports Description

Audit PCI Compliance The PCI Compliance report runs an audit on 
selected assets to validate compliance with 
recommended operating system security 
settings.

This report is available only if you have the 
PCI Compliance Automation Module 
installed.

Audit Change Compliance A stacked bar series graph showing the 
number of configuration changes for a 
specified time period. Configuration changes 
refer to provision, update, and tracking alert 
activity.

Activity Change Summary A table that shows all provision, update, and 
tracking alert activity during a selected period 
by project.
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Planning Job Schedules A table that lists jobs currently scheduled for 
execution, either on a recurring basis or as a 
one-time event. These include tracking, 
provisioning, comparison, and report jobs, as 
well as one-time events such as automation 
module script execution.

This report is useful for uncovering potential 
bottlenecks in scheduling activity.

Planning Tracked Assets Lists complete information about assets being 
tracked, including owner, number of 
configurations, whether auto-update is 
enabled, and so forth.

Planning Non-Tracked Assets Lists information on assets that are not being 
tracked. Such a list is helpful in deciding 
whether certain assets should be tracked.

Planning Change Volume A bar series graph that shows the number of 
changed configurations in projects over a 
specified time period. Configuration changes 
refer to provision, update, and tracking alert 
activity.

Comparison Comparison Specification Select from a list of saved comparisons to 
generate a comparison report in the browser 
window.

Comparison Comparison Activity Lists alerts raised by scheduled comparisons. 
It provides the date and time that the 
difference was detected and the name of the 
saved comparison that resulted in the alert.

Administration Groups and Memberships Lists all or selected groups in Application 
Configuration Console and their members. 
Groups are used to set permissions on shared 
objects.

Administration Roles and Permissions Lists all assets in a project (for which you 
have read permission), and information about 
each one related to ownership and 
permissions.

System Info System Summary A table that shows a high-level view of the 
data being managed in Application 
Configuration Console.

System Info Host and Asset Details Lists the assets on each host known to 
Application Configuration Console. Asset 
details include a count of the number of assets 
on each host and the asset owner.

Note: You can easily integrate your own custom reports into the Web 
Reports browser interface so that they are available on the menu bar 
to be generated and scheduled just like the standard reports.

Table 7–1 (Cont.) Summary Descriptions of Individual Web Reports

Category Reports Description



Try It Out

Web Reports 7-3

7.3 What You Can Do
Besides generating Web Reports based on various criteria you supply, you can also do 
the following:

■ Create and save a generated report in PDF format.

■ E-mail a PDF version of a generated report.

■ Export report data as a delimited text file (CSV).

■ Schedule a report to run automatically on a recurring basis; arrange to e-mail the 
report output.

■ Run a saved comparison and print out the resulting comparison table or export it 
to a spreadsheet.

7.4 Try It Out
Rather than spend any more time here on Web Reports, why not take it for a test drive. 
Let's assume you have completed the exercises in the previous chapters. Now we are 
going to generate a couple of sample reports to review some of the activities 
performed earlier.

1. Log in to Web Reports as described in the beginning of this chapter.

2. From the Planning menu, choose Tracked Assets.

3. In the Navigator tree on the left, select the Portal Lifecycle View project.

4. Click the Generate Report button.

The report that results should denote tracking set on the Server1 asset, as performed in 
Chapter 5. As the report shows, although the asset has four configurations, we set 
tracking only on one file (config.xml, in this case).

Try another one.

1. From the Activity menu, choose Change Summary.

2. In the Navigator tree on the left, select the Portal Lifecycle View project.

3. Click the Generate Report button.

4. In the report that results, locate the tracking Change Type row for Server1. Click 
the pair of numbers in the Revision column.

A Change Detail report opens in a new browser window that shows the difference 
detected that generated the alert. Notice the link on the right (Compare Content); click 
it to compare the value in Application Configuration Console to the current value in 
the external resource.

If you didn't perform the exercises in the book, load some data now into Application 
Configuration Console and perform some tasks so you have activity to report on. Use 
the Web Reports Online Help for guidance in generating and dispersing reports.
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Alert

Alerts denote differences detected as a result of scheduled events. You can use alerts as 
a simple notification system, or you can use an enhanced version to manage alerts 
systematically.

Managing alerts involves a more formalized approach where someone takes 
ownership to investigate and eventually resolve the issue. In addition to the current 
status, a managed alert also denotes who works on and resolves the issue, when it was 
resolved, and what the resolution was.

See also Tracking Alert,Comparison Alert.

Alerts View

The portion of the Application Configuration Console Client window (lower-right 
pane) where alerts are announced and from which you can right-click to take any of 
various actions on an alert.

Asset

The key component in Application Configuration Console. An asset is defined by the 
union of a host/endpoint, an authentication pack, and a resource specification. These 
three things uniquely identify an External Resource. Assets represent the servers, 
devices, and systems that you manage. For example, Web servers and application 
servers are both represented as assets. Assets typically contain one to many 
configurations.

See also Master Asset,Subordinate Asset.

Asset View

A way of arranging the configurations of an asset. An asset view may contain all the 
configurations of an asset or some subset of configurations. Asset views are especially 
useful for assets with deeply-nested configurations, or assets with subsets of 
configurations that are of interest to different groups of users. You can also use an asset 
view to rearrange configurations and group them into different folders

Asset View Specification

The rules for creating an asset view are defined in an asset view specification. Some 
automation modules contain ready-to-use asset view specifications, such as the 
WebSphere Servers View in the WebSphere automation module. You can create 
additional asset view specifications, and then apply them to assets.
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Authentication Pack

Often shortened to auth pack. A centralized, reusable, and convenient method to store 
access credentials for remote systems. An authentication pack contains a username 
and password (encrypted), or an SSH certificate and passphrase, or similar credentials. 
All Application Configuration Console users can create authentication packs, and they 
can share them with other users (passwords are always hidden). This alleviates the 
need for each user to have an account on each remote system, and changes to 
credentials only need to be made in one place.

Automation Module

An automation module brings enhanced functionality to Application Configuration 
Console. As the name implies, an automation module contains "automations" that 
combine many complex steps into simple operations. Automation modules also 
include dictionaries that contain specific properties and values appropriate for the 
automations. Application Configuration Console currently offers automation modules 
for IBM WebSphere application servers (versions 5.1 and 6.0), BEA WebLogic Server 
(versions 8, 9, and 10), and Windows 2003 Server.

Base Directory

A directory on a remote host that is identified in a File Resource Specification or an 
asset as the starting point from which all relative paths to files or directories defined in 
the resource spec are based.

Breadcrumbs

A locator tool that shows where you are in the Navigator View relative to the top of 
the hierarchical tree. The trail of breadcrumbs appears in a horizontal line above the 
Navigator view; each "crumb" in the trail is a hyperlink to the corresponding location 
within the hierarchy.

Command Line Interface (CLI)

The CLI is another method of accessing Application Configuration Console data and 
commands, in addition to the Client interface. The primary function of the CLI is to 
provide an interface for scripts to interact with Application Configuration Console. 
You can also type CLI commands manually to execute several of the commands in the 
Client interface.

Command Resource Specification

Lists a remote command or group of commands to be run in order to save the output 
in a configuration. The remote commands can be native commands of the remote 
device, or they can be scripts of some kind. You can run the commands directly or 
through sudo to have the benefits of sudo control and logging. You can run the 
commands through su to execute the commands under another user login. Interacts 
with a Command Resource Adapter.

See also Resource Adapter.

Compare

To evaluate two or more containers or configurations for any differences between the 
elements being compared. You can compare individual configurations or entire 
container trees. You can compare configurations within Application Configuration 
Console or to their external resources. You can also compare content, that is, raw 
(unparsed) text of configurations.

See alsoSynchronize View.



Deferred Provisioning

Glossary-3

Compare View

A display that appears in the Application Configuration Console Editor area 
(upper-right pane of the Client), highlighting the differences uncovered in a 
comparison, from which you can take corrective action.

Comparison Alert

A difference detected between assets or configurations as a result of a scheduled 
comparison.

Comparison Key

Metadata that you can assign to a container to substitute a different container name for 
the purpose of comparison.

Configuration

An object that contains configuration information, such as properties and their values. 
Assets contain configurations, where each configuration usually represents the 
configuration information from a single configuration file, such as an XML file that 
contains application server settings.

Configuration View

A representation of your configuration data that is created with a specific Transform. 
Different transforms can help you see different aspects of your configuration data by 
rearranging attributes and elements and character data. Primary View and Physical 
View are examples of configuration views.

Connector

The combination of Host, Authentication Pack, and Resource Specification that 
enables Application Configuration Console to read and write configuration data to 
and from managed servers and devices.

Constraint

A way to test properties for certain values when saving or provisioning 
configurations. Think of a constraint as an “equals” statement, as in “When 
configurationA is provisioned, verify that the value of propertyA is equal to the value 
of metadataA.”

A constraint contains two parts: a Source location and one or more Target locations. 
The Source location points to the value and the Target locations define what is to be 
tested or verified against that value.

Compare to Variable.

Container

Objects that you create in Application Configuration Console to define the structure of 
your system. Application Configuration Console recognizes projects, environments, 
layers, and folders as containers, but you can assign labels to these hierarchical 
containers that match your terminology.

Deferred Provisioning

Refers to the ability to schedule at a later time a once-only Provision operation for a 
particular container or configuration. Useful for example to defer a time-consuming 
provision until off-peak hours.
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Dictionary

Also called a property dictionary. Contains definitions that set a property type and 
valid values. For example, an HTTP_Port property could be defined as an integer that 
can only have a value of 80. Many properties use the GenericString definition, which 
does not enforce any restrictions.

Editor Area

The portion of the Application Configuration Console Client window (upper-right 
pane) where the contents of configurations and Metadata about containers and 
configurations display. When you double-click an item in the Navigator view, 
Application Configuration Console opens it in the Editor area for further operation. 
You can open multiple items simultaneously.

Effective Permissions

The overlap of the permissions on a container and the permissions on a top-level 
shared container. A user group must have write permission in both locations to have 
effective write permission. For example, if a group has read and write permission on 
an asset, but the asset is shared under a Project that only has read permission for that 
group, the effective permission is read only—the write permission does not exist in 
both places so it is not effective.

See also Permissions.

Endpoint

Protocol (FTP, SSH, UNC) used to transfer information over the network. Specified in 
combination with the host where the external resources reside.

Environment

Usually the first level under a project. A typical use is to represent lifecycle stages for a 
product such as development, quality assurance, staging, etc. Environments can also 
be used for geographic locations to make it easy to view assets and resources by 
location. Environments can contain layers, folders, and assets.

Export/Import Capability

You can export comparison results as an HTML file or as a text delimited file and share 
the information with others in your organization who don’t have access to Application 
Configuration Console. You can export system files such as resource specifications and 
property dictionaries as XML files that can be viewed and edited and subsequently 
imported into Application Configuration Console. For example, you can create a 
resource specification to be used as a standard within your organization, export it as 
an XML file, and have others import it into their Clients.

External Resource

The source of files or command responses that constitute an asset and its 
configuration(s). A resource is external in the sense that it exists outside of Application 
Configuration Console, somewhere in a file system on a remote host.

File Resource Specification

Lists the files to be added and managed in an asset. For example, one resource 
specification can identify all of the files to add in an asset for a WebSphere or 
WebLogic application server. Interacts with a File Resource Adapter.

See also Resource Adapter.
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File Template

A complete copy of a file such as a shell script, created from the Physical View of a 
configuration. After you create a file template, you edit it to insert variables. You then 
set values for those variables in every asset that will contain a matching configuration. 
When you apply the file template to a configuration, it replaces the variables with the 
values you set.

Filter

In general, the capacity to apply criteria to refine a returned list. Application 
Configuration Console provides several filtering options, including alerts, jobs, 
synchronize views, rules specifications, and wildcard pattern matching on file resource 
specifications.

Find and Replace

Powerful search mechanism within Application Configuration Console that lets you 
search for, among other things, properties and values, container names, various 
settings, users and groups, and Metadata. The mechanism validates replacement 
values so that you cannot set invalid values.

Folder

The Navigator view contains three top-level folders:My Workspace Folder, Public 
Workspace Folder, and System Folder. Folders also are optional organizational 
containers that you can use as needed to organize and categorize assets. You can add 
folders at any level of the hierarchy between projects and assets.

Group

Groups control which users have permission to view and change information in 
Application Configuration Console. A group contains one or more Application 
Configuration Console users. When you share a container or configuration, you set 
permissions for groups of users, not individual users. You can give different 
permissions to different groups, such as read permission or write permission.

Host

An addressable machine in your network where external resources reside. A host has 
an associated endpoint or protocol to use when connecting to it.

Import

See Export/Import Capability.

Jobs View

The portion of the Application Configuration Console Client window (lower-right 
pane) that lists scripts that are running. The scripts might be part of an automation 
module, or they could be created by someone in your organization. Also lists deferred 
provisions set up to run as one-time only.

Layer

Layers can contain folders and assets. Layers are often used to represent technology 
layers contained in an environment, such as the Web server, application server, and 
database.

Link

A link is a way to see and open a container and its children (or a configuration) from a 
different location. Linking allows you to organize items in a way that's convenient for 
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you. For example, your configuration data may be arranged by projects, with each 
project having its own application servers. You can create a new project and add links 
to all the application servers so that they all appear under one project, which makes 
them easy to locate and compare.

Make Configuration Changes Live

The ability to edit certain registry files on the Application Configuration Console 
Server directly within the Client and render the updates in real-time without 
interrupting server operations. There are other registry edits that require you to restart 
the Server to effect the changes.

Mapping

Application Configuration Console uses custom mappings to load external resources 
(usually configuration files) into the configuration database and to provision 
configurations out to external resources. Mappings convert the different formats used 
in external resources into a standard format that is used internally, and then 
transformed to a structured configuration view. Non-structured files and binary files, 
such as shell scripts and .ear files, don't have mappings.

Compare to Transform.

Master Asset

A master asset is a regularAsset from which other (subordinate) assets are “cloned;” 
that is, the cloned asset has the same makeup (set of configuration files) as its master. 
When you change the master asset, you propagate the changes by refreshing its 
subordinate assets.

An asset can become a master in a variety of ways. You create a new asset based on an 
existing asset. The existing asset becomes the master to the subordinate that was based 
on it. You take an existing asset and assign it master status by declaring another 
existing asset as subordinate to it.

Contrast with Subordinate Asset.

Metadata

Metadata takes two forms. As system-defined, metadata is annotational information 
about a container or configuration, such as when it was created or who last made 
changes. Metadata can also be user-defined, and as such, is most commonly used to 
drive value substitution for things such as comparison settings, variables, Navigation 
view hierarchies, and so forth.

Multiprovision

The act of provisioning a master asset and some or all of its subordinate assets in a 
single action. Multiprovisioning affords a convenient way of making configuration 
changes in one place and distributing these changes across multiple servers that have 
the same set of configuration files.

See also Master Asset,Subordinate Asset, Provision.

mvPath

mvPath is an expression language for referring to objects in Application Configuration 
Console such as containers and properties. Use mvPath when specifying variables and 
constraints, when using the command line interface, and when writing your own 
scripts. In the mvPath view of configuration data, everything is a container except for 
properties and Metadata. Projects, environments, layers, folders, assets, 
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configurations, views, and configuration elements are all containers. Both containers 
and properties can have metadata, and properties and metadata can have values.

My Workspace Folder

Or simply My Workspace. A hierarchy of projects, containers, and configurations 
within Application Configuration Console that is your private work area, and as such, 
cannot be seen by anyone else. When you share something in My Workspace, it 
becomes visible in the Public Workspace folder to those you share with.

Contrast with Public Workspace Folder.

Navigator View

The portion of the Application Configuration Console Client window (upper-left 
pane) that displays your projects and configurations and how they relate to each other 
in a hierarchy, similar to a file explorer. In Application Configuration Console, all 
configuration information is organized under projects. Projects can contain other 
containers and/or assets with configurations.

Normalize

On comparisons that detect differences across two or more configurations, you can 
normalize the row in the comparison view where a difference is detected; that is, you 
can set the element or value in each configuration being compared to be the same.

Organizational View

An organizational view can show you your existing configuration data in a different 
organizational structure than the way it was originally loaded. For example, your 
configuration data may be arranged by projects, with each project having its own 
application servers. Because of the project hierarchy, the application servers are several 
levels down under different environments and layers. You can create a new 
organizational view in the project that contains links to all the application servers, 
which makes them easy to locate and compare.

Ownership

In general, anything you create in Application Configuration Console (container, asset, 
resource specification, host, and so forth), you own, which means you control access. 
Others can see items you own in the System folder (hosts and authentication packs, for 
example), but they cannot change them. You can share items you create with others by 
granting permissions to user groups. Shared items become visible in the Public 
Workspace. You can transfer ownership of your items, which means you relinquish 
control over them. In addition, an administrator can transfer ownership of all of your 
resources to another user.

pbrun

A program by Symark PowerBroker that uses access control lists to validate user 
requests based on the user’s credentials and defined privileges. Used in Application 
Configuration Console for Secure Provisioning and remote command execution.

Permissions

See also Effective Permissions.

Physical View

This is the raw text view of a configuration as it is stored in the external resource when 
the asset was loaded or updated. The Physical View does not show any structure 
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except the formatting and new lines from the original file. You can edit a configuration 
in the Physical View, and the data will be validated when you save your changes 
(assuming the file type can be validated).

Preferences

Settings you can establish to customize certain aspects of the Application 
Configuration Console Client interface. Preferences include such items as whether to 
remember or prompt for the server URL, and whether to require a tag field on 
provision and update operations. Preferences is a Window menu selection in the 
Client.

Preview

For configuration files of any type, you can validate the file and preview both the 
Primary (parsed) View and the Physical View as you create the resource specification, 
before you attempt to load an asset using the resource spec.

Primary View

This is the parsed view of a configuration transformed for display in the Editor area 
based on file type, such as XML. A typical display is property name/value pairs 
within elements. You can edit the contents within the Primary View. You also can add 
new elements and properties to the configuration.

Project

Projects are top-level containers that can contain any other organizational container, 
including other projects. In Application Configuration Console, projects are typically 
used to represent real-world projects or applications such as an Internet portal or a 
401K program. You can create a system view for a project to see the relationships of the 
containers that make up that project.

Property

Properties together with their values constitute configuration information in 
Application Configuration Console. For example, you might have a configuration for a 
Web server that contains a property named port with a value of 1080. Properties are 
always displayed in a configuration view. Most configuration views use a transform to 
organize the properties into a structure of elements that shows the relationships 
between the properties.

Property Dictionary

See Dictionary.

Provision

Provision is the act of committing, or writing out, configuration information from 
Application Configuration Console to external resources, such as an XML 
configuration file for an application server. Configuration changes that you make in 
Application Configuration Console will have no effect on external resources until you 
provision the changes.

Provision is the only Application Configuration Console action that modifies an 
external resource.

Contrast with Update. See also Deferred Provisioning, Secure Provisioning.

Public Workspace Folder

Or simply Public Workspace. A hierarchy of projects, containers, and configurations 
within Application Configuration Console that can be seen by everyone.



Scheduling

Glossary-9

Contrast with My Workspace Folder.

Query

Application Configuration Console has a querying capability that lets you see 
relationships between connectors and containers and learn how they are being used. 
For instance, you can query on which assets are using a specific authentication pack, 
host, or resource specification. Perhaps you want to know if a particular authentication 
pack has had recent activity, such as any write operations in the last three days.

Resource

See External Resource.

Resource Adapter

An underlying software driver that resource specifications use to load assets. 
Application Configuration Console uses command, file, and Windows resource 
adapters.

Resource Definition

The details portion of a file or command resource specification where you define the 
make-up of the external resource, such as the file name and type of mapping to use or 
the command and arguments to execute.

Resource Specification

Often shortened to resource spec. Identifies the files and resources that can be loaded 
as assets into Application Configuration Console from remote systems. There are two 
types of resource specifications: one, File Resource Specification, for loading files and 
directories; the other,Command Resource Specification, for saving the output of a 
command.

Also commonly referred to as Signature.

Resource View

The default asset view. The Resource View is a special asset view that shows the file 
and directory hierarchy that exists on the server file system, while other asset views 
show a different arrangement or subset of the same configurations.

Roll Back

To restore a previous version of an asset or configuration following a provision or 
update action.

saveSpecEntry

A saveSpecEntry identifies a series of targets and tasks to be carried out when an asset 
is loaded or updated. The most common example is setting element-level Metadata 
based on the value of a contained property, for use in compare operations.

Scheduling

In Application Configuration Console you can schedule various events to occur either 
on a one-time or on a recurring basis. Scheduled events include the following:

■ Tracking changes

■ Saved comparisons

■ Provisioning

■ Web Reports generation
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Secure Provisioning

The capability within Application Configuration Console to perform Provision 
operations in enhanced-security environments. Secure provisioning writes 
configuration files to a Temporary Directory on a remote system and then uses a sudo, 
pbrun, or su command to copy the files to a secure location.

Sharing

You can share anything that you create in Application Configuration Console with 
other users. Shared containers and templates appear in the Public Workspace Folder. 
Items that you share in the System Folder, such as hosts and resource specifications, 
become visible to other users in the System Folder.

Only the owner of an item can share it. When you share an item, you set permissions 
that define which groups can see and use that item and its children.

Specification

SeeCommand Resource Specification, File Resource Specification.

su

A command that changes user credentials to those of the root user or to some other 
specified user and then initiates a new session on a remote system. Used in 
Application Configuration Console for Secure Provisioning and remote command 
execution.

Subordinate Asset

A subordinate asset is one that derives its makeup ( set of configuration files) from 
another asset that has been declared its master. You never edit or update the 
subordinate asset directly. Rather, you refresh a subordinate from its master to include 
changes made to the master asset.

An asset can become a subordinate in a variety of ways. You create a new asset based 
on an existing asset. The new asset becomes subordinate to the asset on which it is 
based. You take an existing asset and assign it subordinate status by declaring another 
existing asset as its master.

Contrast with Master Asset.

sudo

A command through which a system administrator delegates authority to give certain 
users (or groups of users) the ability to run some (or all) commands as root or another 
user while providing an audit trail of the commands and their arguments. Used in 
Application Configuration Console for Secure Provisioning and remote command 
execution.

Synchronize

To determine whether changes exist in Application Configuration Console or the 
external resource and then to make them the same by updating one or provisioning 
the other.

Synchronize View

Provides a way to identify changed configurations in Application Configuration 
Console and changed external resources, and then to use a Provision or an Update 
action to synchronize the two. Use the Synchronize view to compare entire assets or 
other containers to resources.
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System Folder

The System folder contains resources and references, such as authentication packs, 
resource specifications, groups, and dictionaries, to help you work with your 
configuration data.

System View

A system view is a visual representation of the environments and layers in a project, or 
of any two container levels under a selected container. You can use a system view to 
easily see the components in each layer of several environments side by side.

Template

Templates can help you standardize your configurations, which makes it easier to 
create and roll out new systems that conform to those standards. Templates are 
essentially copies of existing containers and configurations. You typically add 
constraints and variables to templates for any values that need to change in each 
environment, such as a server hostname. When a template is ready, you can create new 
containers or configurations based on the template.

Temporary Directory

Used in Application Configuration Console forSecure Provisioning operations. This 
refers to a location on a remote system where configuration files can be written prior to 
being copied to their final secure location.

Tracking

To monitor configurations for the purpose of detecting changes in Application 
Configuration Console or in the external resource. To enable tracking, you specify 
which configurations to track and a schedule. At each scheduled time, the system 
compares the configurations with the external resource. If there are differences, the 
system displays an alert in the Alerts view and optionally sends an e-mail notification.

Tracking Alert

Posting of a difference detected between a configuration and its external resource 
where tracking was enabled on an asset view.

Transform

Transforms in Application Configuration Console convert configuration data from the 
internal storage format to a format that can be displayed in a configuration view. 
When you first load data into a configuration, a parser converts the data into a 
standard format that is used to store the data in Application Configuration Console. 
Transforms convert the data from that format into a structured representation. Once 
you've loaded data into a configuration, you can create configuration views that use 
different transforms to highlight different aspects of the data.

Compare to Mapping.

Update

Update is the act of overwriting configuration information in Application 
Configuration Console with the associated external resources. You can update a single 
configuration, or all configurations under an asset or higher container.

Contrast with Provision.

User Group

See Group.
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Variable

Variables are a method of assigning values to properties, rather than setting the values 
directly. Values derived from variables are retained when configurations are updated, 
so they overwrite values loaded from external resources. You can also use variables to 
set container and property names and Metadata, but they are most commonly used for 
property values.

Compare to Constraint.

View

A pane within the Application Configuration Console window, such as the Navigator 
view, Alerts view, or Jobs view.

See also Asset View,Configuration View, Organizational View, Synchronize View, 
System View.

Web Reports

A Web-based reporting component that you can use to display Application 
Configuration Console data in a variety of textual and graphical formats. You can 
generate reports in real time or schedule them to run at specific intervals, with the 
output sent to an e-mail list. You also can export reports in PDF and CSV formats.

WebLogic Automation Module

See Automation Module.

WebSphere Automation Module

See Automation Module.

Windows Resource Extensions

The Windows Resource Extensions (WRE) adds capabilities to Application 
Configuration Console for working with Windows Servers and resources. The WRE 
includes a Windows automation module that loads a set of resource specifications 
designed to extract configuration and other information from Windows servers. These 
resource specifications interact with a Windows Resource Adapter.

See also Automation Module,Resource Adapter.

Workspace

See My Workspace Folder,Public Workspace Folder.
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